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Details of the compound, data and software

Time-of-flight diffraction data at POWGEN: 

PG3_42702-2_300K.dat (Paramagnetic phase @ 300 K)

PG3_42704-2_10K.dat (Magnetically ordered phase @ 10 K)

Instrumental resolution file:

PG2018B_HighRes_60Hz_b2_Ddep.irf 

Crystal Information File for crystal structure:

CrSbSe3.cif 

Mag2Pol version used: 7.0.4

Orthorhombic structure: Pnma (No. 62) 

a = 9.143086 Å, b= 3.784552 Å, c=13.416915 Å
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The main interface of Mag2Pol
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The main window of Mag2Pol - GUI

Running the Mag2Pol application, the main window  

‘Mag2Pol’ will open. By default, the interface may look 

slightly different. You can modify this under the menu 

‘View’

This window should remain open as long as any other 

Mag2Pol utility or window is running. The current 

version of Mag2Pol will not save the project 

automatically, so make sure to save any project before 

closing this window. 
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Menu items (icons) on the main window relevant for this tutorial

4
Bonds: Opens a new window that is used to modify the visuals of the 

structural model [active after loading the structure file, if it is not active even 

after loading the cif file, press Ctrl+U (on Windows) or Cmd+U (on Mac)].

Irreducible representations: Opens a new window that provides details of 

irreps and lets you select one or more irreps for the refinement of magnetic 

structure (active when at least one magnetic ion is defined)
5

Sample info: Opens a new window that provides details of, lattice and 

magnetic structures and the results of the last refinements.
6

Spacegroup tables: Opens a window on which you can select magnetic space 

group (Shubnikov group) instead of irreps, to refine the magnetic structure.
7

Fit: Opens the window where you can choose the data file, and instrument 

resolution file, and perform the refinements. 
8

Settings: Opens a new window that lets you modify a few important settings 

about GUI, a graphical rendering of plots and figures, and also the refinement 

procedure. 
9

1 Open: Load a structure file (cif) or an existing Mag2Pol project (xml).

2 Save as: Save a new Mag2Pol project (as *.xml).

3 Save: Append the currently working project with the same name.

Manual: Opens Mag2Pol manual in pdf format. 10

1 2 4 5 6 8 10

97
3
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Refining high temperature NPD data, collected in paramagnetic phase
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Step 1: Loading the structure or an existing project

7

1
The structure file (*.cif, *.mcif) or existing 

Mag2Pol project file (*.xml) can be loaded by 

clicking this icon or through the menu tree: 

File→Open

In this case: CrSbSe3.cif

2
If the structure file is loaded properly, several 

sections in the main window are populated 

automatically.  



This section can be used to plot/hide a specific 

atom, modify color of an atom, change the 

radius (R) and to change the length of spin (S) 

(if a magnetic vector is plotted)

Optional: Editing structure plot to produce publication-quality figure

Click on Bonds icon, a new window ‘Bonds and polyhedra’ will pop out. You can define and edit the bonds and polyhedral of the graphic here. If the Bonds icon is 

inactive even after loading the structure file it can be activated by pressing key board short-cut, Ctrl+U (on Windows) or Cmd+U (on Mac).

Once you are satisfied with the structure plot, you 

can export it as *.png following the menu:

File→Export→Graphic

It is also possible to export the graphic as *.cif and 

*.mcif (in the case of magnetic structure).
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Step 2: Enter the refinement (Fit) window

Within the ‘Fit’ window, you can load the data, load the 

instrument resolution file, and perform Le Bail Profile fit or 

Rietveld refinement. 

To load the experimental data we need to open the ‘Fit’ window, by clicking on the icon as shown in the screenshot below (or the keyboard shortcut ‘Ctrl+F’).
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Step 2a: Load the experimental data

The data can be loaded under the ‘Data’ tab of the ‘Fit’ window. Mag2Pol can accept three kinds of data sets. In this example, we will start with ‘Powder diffraction 

data’ of CrSbSe3 collected at 300 K (Paramagnetic phase).  Follow the order indicated below.

3

4

Select the data format 

‘x y Sigma (Ins 10)’

Click on ‘Load pattern’ and select the 

data file when prompted. In this case:

 PG3_42702-2_300K.dat

Activate ‘Refine nuclear structure’

1
We are under the ‘Data’ tab

10
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Step 2b: Confirm all the atoms are loaded properly

Under the ‘Atoms’ tab, check if all the atoms are loaded properly and the occupancies nominally follow the chemical formula. Do not select any of these parameters for 

refinement, at this stage.

11

We are under the ‘Atoms’ tab



Step 2c: Load the instrument resolution (irf) file

3

2

1
Under the ‘Patterns’ tab

Select neutron as the ‘Source’ 

12

Right-click on the text ‘Geometry’ and follow the menu items 

as shown in the screenshot, to load the appropriate irf file for 

the experimental dataset (data bank). In this case: 

PG2018B_HighRes_60Hz_b2_Ddep.irf  



Step 2d: Check the peak function and set an appropriate scale factor

Adjust the value of the ‘scale’ factor so that 

the intensities of the calculated pattern 

roughly match those of observed data. 

Also, select it for refinement, by ticking the 

button in front of the scale factor value.

3

Toggle the legend ON/OFF

1

2
Make sure the peak function is: PV * B2B exponential (Tof1)

If the irf file is loaded properly this should be updated 

automatically. If not choose it manually.
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Step 2e: Select the region to exclude from the fit ‘Excluded region’

Toggle the ‘excluded regions’ ON

1

On the plot, [Left click + hold] 

and drag on the region needed to 

be excluded.

2

If it is necessary to remove an 

excluded region, right-click on 

this shaded excluded region, it 

will be removed →

3

4
Toggle the ‘excluded 

regions’ OFF

14



Step 2f: Select the background

Right-click on the text ‘Background’ and 

pick a background type. In this case 

background is fairly flat so a polynomial 

with 6 coefficients should be sufficient.1

If the ‘Background’ type is ‘linear interpolation’, then 

one can select an appropriate number of background 

points by right-clicking on the baseline of the 

diffraction pattern.

(Only for BG type ‘linear interpolation’) 

For manual background selection toggle this ON 

(toggle it OFF after selection is complete)

2
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Step 2g: Activate refinement of background

To activate refinement of the background, Right-click 

on the text ‘value’ and select ‘check all value’
1

Make sure the origin value of the 

background is somewhere in between the 

selected data range for refinement. In the 

current example, 90000 microseconds
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Step 2h: Select Cell parameters and ΔZ0 for refinement
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Step 3a: Run the first refinement run

2

1
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Step 3b: Results after the first run of the refinement 

Convergence reached after 31 cycles! Discrepancy 

parameters and all the refined parameters can be found in 

the left window.
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Step 3c: Refine instrument parameters

1

2

3

In the current version, it is necessary 

to choose a small value when starting 

the refinement of a new parameter. 

Leaving them to be zero won’t work.

4 Back to the fitting tab and run fitting again till the fit converges.
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Step 3d: Significant improvement in the fit

21



Step 3e: Refine atomic parameters

Refinement of atomic parameters can be activated by 

right-clicking on the text, ‘x’, ‘z’, and ‘B’ and selecting 

‘check all x/y/B’. They can also be selected one by one.

In some cases, starting the refinement of both positions 

and thermal parameters might lead to divergence or 

local minima, so refine positions (x, y, z) first and then 

activate and refine thermal parameters (B).   

1 2 Back to the fitting tab and run fitting again till the fit converges.
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Step 3f: The fit looks good; accept this as final refinement result.

1 Accept the fit results by clicking on this button.

At any stage, if the fit diverges, you can recover previous states by pressing 

‘Undo’ button. It can go back as many steps as you want, all the way back 

to the initial state of the refinements of the current session. 23



Step 3g: Export the refinement profile as a PDF or ASCII file.

1

3
Export the PDF of the 

plot as seen here or as 

ASCII data to plot using 

external programs.

2
Can toggle x-axis between - t.o.f (microseconds); d (Å); Q (Å-1)

4
Close the ‘Fit’ window, and 

go back to the main Mag2Pol 

window.

24



Step 3h: Save the Mag2Pol project (*.xml). It's a very crucial step!

1 Save the project with an appropriate name. In this case, CrSbSe3_300K.xml

In the current version of Mag2Pol, the project (*.xml) 

file will have all the refined parameters and absolute 

paths for data and irf files. The project file can be 

reloaded without any issue later. But if it is opened in 

a different computer with a different folder structure, 

it will complain about missing data and irf files file 

and prompts to choose the file path. Choose the right 

file format and indicate the file path; it will reload the 

project in its original.

Export the new Graphic as 

*.png or structure as *.cif file

2
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Refining low temperature NPD data, collected in the magnetically ordered phase
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Step 4a: Start with the project created for the high-temperature phase in Step 7f.

1
Save as a new project, with appropriate name for the low-temperature 

phase. To begin with, we will only consider lattice contribution.

2
Click this icon to open the ‘Fit’ window.

We will be using the refinement results of 

high-temperature data as a starting point 

for the refinement of low-temperature data. 
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Step 4b: Replace the old data with the new data.

1 Select the data format ‘x y sigma (Ins 10)’

Right-click on the old data, select the ‘Replace’ 

option and pick the new data set when prompted.

In this case loading: PG3_42704-2_10K.dat

2
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Step 4c: Fix all the atomic parameters

1

At this stage do not refine any of the atomic 

parameters. Fix them by unchecking one by one 

or by right-clicking on the column name and 

selecting ‘uncheck all’

2
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Step 4d: Refine the scale and Cell parameters

Fix all parameters except the 

‘scale’ and ‘Cell’ parameters. 

1

3

4
Go to the fit tab and run the 

refinement till the fit 

converges.

30

NOTE: If the new data set that was loaded in 

this section is measured with a different 

center wavelength (data bank) than the 

previous data set, then make sure to load the 

corresponding irf file. And need to refine the 

profile, Time of flight, and Rise and decay 

parameters as necessary, before proceeding 

to the next point (3).

In the current case, both 300 K and 10K data 

sets were collected with the same center 

wavelength neutrons, so no need to change 

the irf file.
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1

The fit profile looks good except for the 

data set at the higher d-range, where the 

contribution from magnetic scattering is 

significant.

2

Step 4e: Refine profile parameters as necessary

3
Select profile parameters for 

the refinement

4
Go to the fit tab and run the 

refinement till the fit converges.

5
After convergence is reached click 

on the ‘Accept’ button (under Fit 

tab) and close this ‘Fit’ window.
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Step 4f: Back to the main window of Mag2Pol

We have refined only the lattice 

contribution so far, and now we can define 

the magnetic ion and proceed with the 

refinement of the magnetic structure.

1
Save as a new project, with an appropriate name for the low-

temperature phase. In this example, CrSbSe3_10K_Lattice.xml 
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Refinement of magnetic structure
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Step 9: Define the magnetic ion

Under the ‘Atoms’ section:

Depending on the type of magnetic 

contribution, simply add the prefix M or J to 

the magnetic ion followed by the ionic state. In 

this case only Cr3+ is magnetic.

After this, update the structure by the key 

board shortcut [Ctrl+U] (on Windows) or 

[Cmd+U] (on Mac) 

1

2

As soon as a Magnetic atom is defined under 

the ‘Atoms’ section, the ‘Spins’ section will be 

populated automatically with the Magnetic 

ions. By default, the Propagation vector is set 

to (0, 0, 0). Leave everything default.

3
Open the fit window by 

clicking this icon
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Searching for propagation vector (q-vector) from the satellite peaks
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Step 5a: Zoom into the diffraction pattern and activate ‘Satellites’ window

1

2
Zoom into the section of the diffraction pattern 

where you see magnetic peaks (at higher d-range)

5

Click on the ‘satellites’ tab which 

will open a new window 

3
Activate the ‘magnetic’ option by 

ticking this button. If this is not 

selected option (5) will not work.

Make sure the magnetic peak profile 

function is the same as the nuclear 

profile. If not select it manually.

4
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Step 5b: Select satellite (magnetic) peaks

Left-click on the center position of each satellite (magnetic) 

peak, indicated by green arrows in this example.

Move this ‘Satellites’ window away so 

that the diffraction profile on the ‘Fit’ 

window is accessible. 
1

2
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Each selected satellite peak will have a blue vertical 

column. The position of the blue vertical column can be 

altered using a mouse (left-click + hold + move) and can 

be removed by right-clicking on it

1

Step 5b: Select satellite (magnetic) peaks

This is the list of satellite peaks 

that is automatically populated 

upon their selection on the ‘Fit’ 

window as indicated by option (1)

Select an appropriate q-vector 

type expected based on the lattice 

symmetry and ‘Step size’, to limit 

the search time. I will go with 

defaults in this example. 

3

2
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Step 5c: Run the q-vector search, and note down the best q-vectors

Clicking on ‘Find q-vector’ 

will run the search routine. 

1

2
List of 20 best q-vectors that 

fit the selected satellites best, 

Populated automatically after 

running ‘Find q-vector’.

The best q-vector is listed here 

by default, after running ‘Find 

q-vector’. 

In this case it is (0, 0, 0)

3
The position indicated by Cyan columns here corresponds 

to the calculated peak position corresponding to the 

selected ‘propagation vector’ on the ‘Satellites’ window 

[section indicated in option (2) on this slide].

4

Note down all the propagation vectors that you wish to 

try out. Close both the ‘Satellites’ and ‘Fit’ windows. 

And go back to the main window of Mag2Pol. 

5
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Refinement of Magnetic structure
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Step 6a: Update propagation vector and open the ‘Irreducible representations’ window 

Clicking on this icon will open a new window, ‘Irreducible representations’. This may not be 

active if the structure is not updated using the keyboard shortcut after updating the q-vector.   2

If the propagation vector is other than 

(0,0,0), change it here. And update it by 

pressing the keyboard shortcut ‘Ctrl + U’ 

(Windows) or ‘cmd + U’ (on Mac). In the 

current case, it is the default value.

1

3

The newly opened ‘Irreducible representations’. 

Contains details of magnetic representations for 

the given wave vector.
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Step 6b: On the ‘Irreducible representation’ window select an irrep (Γn) for the refinement

The ‘Symmetry’ tab provides some details of 

symmetry analysis and magnetic representation

1

The ‘Basis vectors’ tab provides some details of 

Basis vectors of all magnetic sites for an irrep.

2
Choose an irrep to see 

the Basis vector details

Basis vector ψ1  of irrep Γ1 for the Site 1 

of the magnetic ion.   

If the magnetic moment is not allowed at a 

site this space will be empty for that site.

If there is more than one magnetic site they 
appear as different tabs: Site 1, Site 2, etc.

1

The ‘Irreps’ tab lists all irreps.

Right-click on one of the irreps symbols (Γ1 in 

this example), consequently click on ‘Use Γ1’ 

Go back to the main window of Mag2Pol 
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Step 6c: Back to the main window, save the project

Save as a new project indicating irrep in the file name. 

For example, for this example, the project can be 

saved as  CrSbSe3_10K_Mag_G1.xml1

2
Open the fit window by 

clicking this icon
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Step 6d: Fix all atomic parameters 

On the ‘Fit’ window, under the ‘Atoms’ tab, make 

sure all the atomic parameters are fixed. 
1
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Step 6e: Fix all atomic parameters 

Set the coefficient of the magnetic moment to 

be about 1, and select it for the refinement. 

1

2
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Step 6f: Fix all profile parameters

Fix all parameters except the ‘scale’ parameter.

Also, make sure both ‘nuclear’ and ‘magnetic’ 

phases are active and have the same Peak 

profiles, ‘PV * B2B exponential (Tof1)’

2

1

3
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Step 6g: Perform fit

2

1

After accepting the refinement results on the 

‘Fit’ window (keep this window open), go to 

the main window and click on the save 

button, which appends the previously saved 

project, CrSbSe3_10K_Mag_G1.xml4

Once the convergence is reached, accept 

the fit results by clicking this button.

3

The fitting of magnetic peaks is rather 

poor with the irrep Γ1. We should test 

other irreps.

5
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Test other irreps
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Step 7a: Test all irreps by running built-in Fit macros

1 Select the macro ‘Test irreps’

Click on this arrow to run the macro2

We can test each irrep one by one by selecting them in the main window of the Mag2Pol. But this can also 

be done much faster using the built-in fit macro ‘Test irreps’.
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Step 7b: The macro ‘Test irrep’ ends with the best irrep model

The macro ‘Test irreps’ goes through all irreps and, at the end, reverts to the refinement of the best fitting irreps.  

For the current example, the macro 

tested all 8 irreps.

 

In the end, it went back to the best 

model irrep, Γ7

For this model at this stage, 

𝜒2 = 6.24, RF, mag = 3.19

1 2

The refinement profile for Γ7 looks good. At 

this stage, we can refine Cell and profile 

parameters and atomic parameters in steps, 

which can further improve the refinements.

Once the final refinement of the irrep model is satisfactory, accept 

and transfer the fit results to the main window by clicking on the 

‘Accept’ button.

3

For the irrep Γ7, at the final stage we get; 𝜒2 = 5.04, RF, mag = 2.86

The gamma notation between different programs may not match, so it 

is always a good idea to report the unambiguous, ‘basis vectors’.

For example, Γ3 in the SARAh program is equivalent to Γ7 on Mag2Pol 

Important note:
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Step 7c: Inspect the structure model and save the project

The last accepted fit results were for the irrep Γ7,  so this 

project will be saved as, CrSbSe3_10K_Mag_G7.xml1

As soon as we accept the fit results of a magnetic model in 

the ‘Fit’ window, they are transferred to the main window. As 

we can see here, the magnetic ion in the structure model is 

now appended with a magnetic vector in the irrep Γ7 setting.

2

It is possible to produce high-quality graphics 

(*.png) from within the Mag2Pol. Checkout the 

Mag2Pol manual for more details.

Here is another representation of the magnetic 

structure model in Γ7 setting, produced using 

Mag2Pol. 

3
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Step 7d: Inspect full refinement results

1
Click this icon to open ‘Sample info’ window, which contains detailed information of refined Crystal 

structure, Magnetic structure, and Fit results. Also indicates the path and name of the current project file.

2

‘Sample info’ window, with the 

‘Crystal Structure’ tab active.
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Step 7d: Inspect full refinement results

1

‘Magnetic structure’ tab information of 

magnetic model used in the last refinements.

53



Step 7d: Inspect full refinement results

1

The ‘Fit results’ tab contains detailed 

refinement results of last refinements. 

54



Step 7e: Export refinement results as latex tables

1

A variety of fit results can be copied directly in 

Latex format by following the menu tree:

Tools→LaTeX export
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Step 7f: Export the Graphic and structure models

1

The structure model can be saved as *.png 

(Graphic) or *.cif or *.mcif, by following the 

menu tree:

File→Export
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Refining magnetic structure using Shubnikov groups (Magnetic space groups) instead of 

Irreducible representations.
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Step 8a: Set up a Magnetic Space Group
One way to start this procedure is to prepare a *.mcif file on the Bilbao crystallographic server, download it, and load that *.mcif directly in Mag2Pol. The alternate 

starting point for this procedure would be to use the final version of the Mag2Pol project with lattice-only contribution. For this example, we will start with the saved 

project with lattice-only contribution, CrSbSe3_10K_Lattice.xml 

Set up the magnetic ion1

Change the q-vector if necessary. 

Default values for this example.

2

3
Key board shortcut, [Ctrl + U] (on 

Windows) or [Cmd + U] (on Mac)

Click on the ‘Space group tables’ 

icon to open the new window with 

the same name.

5 Activate the ‘Magnetic SGs’ tab

Type the notation of an appropriate Magnetic 

Space Group or select it from the drop-down menu.

For this example, I choose one of the allowed 

magnetic space groups Pnmʹaʹ.

6

4
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1
Switch to the ‘Preview’ tab

Click on the button ‘Transfer MSG’

Step 8b: Transfer the Magnetic Space Group for the refinement

2

This is updated automatically  to 

the selected Magnetic Space Group
3

4 Save the project with an appropriate name.

For this example, CrSbSe3_10K_Pnm'a'.xml
5 Click this icon to open the ‘Fit’ window.
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2

Step 8c: Perform the refinement using the chosen Magnetic Space Group

3 Click on the fit button

Fix all parameters except magnetic moments 

and scale parameter.

Also, make sure both ‘nuclear’ and ‘magnetic’ 

phases are active and have the same Peak 
profiles, ‘PV * B2B exponential (Tof1)’

1

4

Repeat the fitting by activating more 

parameters in succession until all necessary 

parameters are refined and the fit is 

satisfactory, like the one here.

5
The refinement results using the Magnetic 

Space Group Pnmʹaʹ are identical to those 

obtained using irrep Γ7.
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If you have any questions:

Regarding the experiments and data 

collected at the instrument 

POWGEN, SNS

Contact: 

Qiang Zhang

SNS, Oak Ridge National Laboratory, 

Knoxville, USA 

Email: zhangq6@ornl.gov 

Regarding Mag2Pol and 

need to report bugs.

Contact:

 
Navid Qureshi

Institute Laue Langevin, 

Grenoble, France 

Email: qureshi@ill.fr

Regarding this tutorial

Contact: 

Naveen Kumar Chogondahalli Muniraju

Institute of Nuclear Physics, PAN

Krakow, Poland

Email: naveen.chogondahalli@ifj.edu.pl

Good luck with your next refinement project!
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